Getting started with Mendeley

Katinka Jager en Grietha de Jonge

Carla Gerritsen

ITC faculty library

https://www.itc.nl/library

@LibITC

October, 2020
Table of Contents

1  Mendeley in not even 10 steps .......................................................... 3
  1.1 Go to www.Mendeley.com and register ................................... 3
  1.2 Download Mendeley desktop .................................................. 4
  1.3 Find your browsers bookmark toolbar ................................... 5
  1.4 Install the Word plugin – add-in’s - AtiveX............................... 6
  1.5 Start building your library ...................................................... 7
  1.6 Create your Watched Folder .................................................. 10
  1.7 Inserting citations and references – two ways ......................... 12
  1.8 Change your citation and output style ................................... 13
  1.9 Edit your citation ................................................................ 14
    1.9.1 Add page numbers or prefix .......................................... 14
  1.10 Merging citations .............................................................. 15

2  Mendeley things to know ................................................................. 16
  2.1 Research databases ............................................................... 16
  2.2 The DOI saves the day ........................................................... 16

3  Organizing your Mendeley library .................................................. 18
  3.1 Import other libraries ............................................................ 18
  3.2 Create folders & sub-folders and search the full-text of your library ........................................ 19
  3.4 Where are my pdf’s? ............................................................... 20
  3.5 Read, mark and add sticky notes to the saved articles .............. 20

4  Document-types and output-styles ................................................. 22
  4.1 Different document types ....................................................... 22
  4.2 Not every References needs a hyperlink .................................. 25
  4.3 Output styles ...................................................................... 26

5  Mendeley and BibTex / LaTeX .......................................................... 27
  5.1 Export from Mendeley to BibTex ............................................. 27
  5.2 Automatically create a BibTex files ......................................... 27

6  Mendeley online ........................................................................... 28
  6.1 Create a group ................................................................. 29
  6.3 Create your own profile ...................................................... 30
1. **Mendeley in not even 10 steps**

**Mendeley** is a free reference manager that helps you keep references and literature for your research organized. Start your own information infrastructure right from the start.

You can:
- Create and manage citations of books, articles, and more
- Import citations from online resources and publisher’s websites
- Automatically extract metadata from imported PDFs
- Collaborate with other researchers online
- Highlight and annotate papers and share those notes with others

Because you have a desktop version and an online version that synchronize you can always work anywhere, from any device and have your library up to date. 2GB of online storage is available for free, the Mendeley Institutional Edition (University subscription) provides 100 GB storage.

1.1. **Go to www.Mendeley.com and register**

Two important things:
1. Create your account using your @GMAIL or @student.utwente.nl / @utwente.nl.
2. Create a new Mendeley password, do not use your Canvas account.
3. Make a note of your username and password!
4. Install Mendeley desktop in your documents folder, this way it is easier to back-up your references and more important your pdf’s.
5. Be careful with signing in to Elsevier products (Scopus, Geobase, ScienceDirect, SciVal) with the option “Sign in via your institution” this will create a problem to register with your personal UT mail address. Always use the proxy link from the library website to access databases and sign in with your personal UT login.
1.2 Download Mendeley desktop


From [https://www.mendeley.com/import/](https://www.mendeley.com/import/) Use the options to insert the Chrome or Firefox browser extensions. For Safari or IE, click the grey ‘save to Mendeley’ button and drag it to your Bookmarks toolbar. (See next page how to find this toolbar). You can also do this later from the Tools menu in Mendeley desktop.
1.3 Find your browsers bookmark toolbar

Mendeley in **Firefox** AND **Chrome** Browser: go to [https://www.mendeley.com/import/](https://www.mendeley.com/import/) click the Mendeley import for Firefox, or Chrome depending on which browser you like.

We recommend Chrome or Firefox! Internet Explorer has some issues.

Mendeley does **not** work with **Microsoft Edge**.
1.4 Install the Word plugin – add-in’s - AtiveX

Go to the tools menu in the desktop version. Also you can select another plugin for other word processors.

**Add-Inns:** If your Word Plugin does not appear, try to add this manually via the File menu of Word.

File, Options, Add-Ins (select Manage Word Add-ins), Use the Add button and navigate to your Mendeley installation on your computer.

Some Word installations give **ActiveX** problems. Please see this Youtube for the fix.

[https://www.youtube.com/watch?v=64eq5NFrzgI](https://www.youtube.com/watch?v=64eq5NFrzgI)
1.5 Start building your library
Importing references with the help of the save to Mendeley button from for example Elsevier, Web of Science, ACM or Wiley online library. The first time in any session you want to import a reference you will be asked to sign in with your Mendeley account. Some examples and notes below:

From ScienceDirect by Elsevier.
If you have a search with few results, and click “save to Mendeley”, the export of all references on your screen will start. You can then select the ones you really want from the download list on your screen. Do NOT do this with a result of 12,354 articles! refine your search, or go to one of the articles on your screen and save that one.
From Web of Science (WOS):

To Save references in your Mendeley library from Web Of Science save one reference at a time!

Three more tips:

1. Saving a reference from this kind of bibliographic database that integrates many publisher works best when you use the option “full text from Publisher” because the metadata for a reference is best from the original publisher.

2. To save the PDF of the article in your Watch-Folder is a fast way to generate a reference and have the full text document in your Mendeley library.

3. Use the doi to go to the publisher website: Type http://dx.doi.org/ in your browser, add the article DOI 10.1016/j.habitatint.2015.01.018, this way you have created the fastest route to the publishers website, and the full text http://dx.doi.org/10.1016/j.habitatint.2015.01.018
From ACM digital library

The Mendeley web importer will start and offer you the option to include the pdf, and to select the library folder in which you want to ‘add’ this reference.

- Go to Mendeley Desktop library and sync to import this reference with pdf.

Mendeley now shows you the record, highlighted so you can check and edit the record, and add the pdf by clicking the blue download sign (pdf is not always added directly) if the pdf does not load, save it manually in your Mendeley pdf (watched) folder.

You may have noticed: the pdf is not always automatically imported with the reference.

Drag and drop a pdf to create a reference

- Previously saved pdf’s are easily imported into Mendeley.
- Open the folder for these pdf’s in a new screen, now drag-and-drop the pdf from the folder to the middle pane of the Mendeley desktop library.
Do it yourself record

If importing information via Save to Mendeley or pdf does not work, Use the “Add details manually” button,

You can now easily copy/paste all the information from the source into the relevant Mendeley reference fields.

1.6 Create your Watched Folder

1. in your personal document folders create a new folder calling it ‘MendeleyWatch’ or ‘Add to Mendeley’ you want this to be the dedicated pdf folder for automatic reference import.

2. from your Mendeley desktop library, go to: file, watch folder, navigate to the just created folder to tell Mendeley your preference.

3. Save a pdf in this specific folder that you have designated your watched folder and your references will be added automatically to your library.

Please check this, because the pdf needs to contain enough metadata to form a reference.
This is also how you add a pdf to an already imported reference. In ScienceDirect by Elsevier this also works for the ‘download multiple pdf’ option.

Just a small example, to remind you: Always check your imported reference information!

See text below, same article, different source


http://doi.org/10.18564/jasss.2897
1.7 Inserting citations and references – two ways

1. Go to the reference tab in Word:
   - click insert citation and
   - use the search bar to find the reference you want to insert in your work, type author or a
distinguishing title word(s).
   - Insert by clicking Ok in the Mendeley search bar
2. From the Word, references tab, click insert citation,
   - then on the search bar click the Go to Mendeley button,
   - click the reference to highlight it in your Mendeley library reference list
   - on the top menu bar the “Cite” (Send citation to plugin) button appears
   - click this to insert the selected reference in your Word document.

Citations:
When you start writing a document Mendeley will only add the citation without reference to your
word document.

References:
To add references to your document, first place the cursor in the Word document at the spot
where you want your reference list. Next click ‘insert bibliography’ and from now on Mendeley
will add citation and reference simultaneously.

Chapter 1. ........
(Wielstra et al., 2012)

REFERENCES
Corresponding Mitochondrial DNA and Niche Divergence for Crested Newt Candidate Species.
PloS ONE, 7(9), e40671. http://doi.org/10.1371/journal.pone.0046671
1.8 **Change your citation and output style** by using the drop down menu in Word

![Insert Endnote](image1)

(Olofsson, Holmgren, & Olsson, 2012)

(Zhao et al., 2016)

(Widowski, Verstraete, Pinty, & Gobron, 2003)

Or the View menu in Mendeley desktop

![Mendeley Desktop](image2)
1.9 Edit your citation

In the flow of writing a sentence you may want to place the name of an author outside the brackets. To achieve this simply click the citation and immediately upon doing this your ‘insert citation’ button now says ‘edit citation’. You can now type a bracket before the year and remove the one placed before the author’s name.

When you have finished, put your cursor elsewhere in the text and you will be asked if you want to keep this manual edit.

Later on it is possible to undo this simply by clicking on the citation and use the “undo edit” button. This Mendeley insert citation button has a multi-purpose function!

To completely exclude the author; click the citation, click the now so called ‘edit citation button’ put your cursor on the author’s name in the search bar and click the button “suppress author” this leaves only the Year. The Prefix and Suffix option add text before the author and after the year.

1.9.1 Add page numbers or prefix

1. insert a new citation or edit existing citation

2. Click the citation, so it is highlighted and the ‘insert citation’ button is now called ‘edit citation’.

REFERENCES


3. Click edit citation, and in the pop-up again click the name of the author and this edit screen will appear.

1.10 Merging citations
To add a reference to a citation, or later combine two citations, just add the citation of the other article to your text, highlight them both and now you can see that the ‘insert citation’ button is now called ‘merge citation’ just click this to finish the process.
2 Mendeley things to know

All online resources and help by Mendeley http://resources.Mendeley.com/

2.1 Research databases
If you use research databases like Scopus, Web Of Science, Geobase or CAB for your research, where the Universities Journal subscriptions are integrated with the database, you may have to click a few times to get to the publishers site before you can download the full text pdf with the necessary metadata. Or type http://dx.doi.or/ in a new browser tab; add the DOI http://dx.doi.or/10.1016/j.isprsjprs.2010.06.005 and you will go straight to the publisher’s website
Importing the references from the original publisher’s website gives the best metadata.

2.2 The DOI saves the day
If you have trouble exporting your references, try to find the DOI (Digital Object Identifier) of your article, put it in a New Reference (File, Add entry manually) and the Lookup function will complete your reference!
2.3 Literature Search in Mendeley Crowd-sourced online research catalogue

You can use the literature search – bar in Mendeley.

Which database are you using with this search option?

- It accepts Boolean operators, AND, OR and Not
- Truncation is possible: mode*ing for modelling or modeling
- Just tick the dot before one of the found references to save it to your library

Be aware that most publication types are not properly recognized, given as “generic” in the database. Use the look-up function with each reference to complete the reference.
3 Organizing your Mendeley library

3.1 Import other libraries

Endnote or other libraries can be imported, into Mendeley desktop library, take the next few steps:

Starting from Endnote:
1. Select all references
2. Go to ; File, and Export
3. Select location : save in
4. Choose : file name
5. Save as type: XML
6. Output style : Endnote Export OR RIS
7. Tick the box: export selected references
8. Save
Go to Mendeley:

1. Go to: File, import, Endnote OR RIS
2. Navigate to the file you have just save
3. .. and import
4. Mendeley will check for duplicates

3.2 Create folders & sub-folders and search the full-text of your library

Right click anywhere in the left hand pane to create folders and sub-folders. You can drag and drop files into folders from anywhere. We recommend starting with search to help find things fast. The real usefulness of folders is for reducing the scope of your search.

Search for a keyword, title words, authors in the top right search bar to find documents instantly as you type.

This search bar is context sensitive, so if you are reading a pdf, it will search the full text of the pdf (pdf type permitting)

The search includes global notes and tabs by default and you can filter specifically by clicking the filter arrow.
3.4 Where are my pdf’s?

A right mouse click on a saved pdf, from your desktop library will tell you where Mendeleyev has saved it.
See 3.6 for file organization

3.5 Read, mark and add sticky notes to the saved articles

If you double click one of the references in your Mendeley desktop the pdf will open, you can read, make notes, use the highlighter. Etc.
You can share this paper with annotations with your, supervisor or colleagues, via: File, Export pdf, and in the next popup select, pdfs + notes or Notes only.

positioning

Richard Knippers
Klaus Tempfli

Introduction
In the early days of geoinformation science, spatially referenced data usually originated within national boundaries, i.e. these data were derived from printed maps published by national mapping organizations. Nowadays, users of geoinformation are combining spatial data from a given country with global spatial data sets, reconciling spatial data from published maps with coordinates established by satellite positioning techniques, and integrating their spatial data with that from neighbouring countries.

To perform these kinds of tasks successfully, we need to understand basic spatial referencing concepts. Section 3.1 discusses the relevance and actual use of reference surfaces, coordinate systems and coordinate transformations. We will explain the principles of spatial referencing as applied to mapping, the traditional application of geoinformation science. These principles are generally applicable to all types of geospatial data.

Section 3.2 discusses satellite-based systems of spatial positioning. The development of these global positioning systems has made it possible to unambiguously determine
3.6 Automatically organizing your pdf's

From the Tools menu, select options and the File organizer tab. You can ask Mendeley to sort, rename and store your pdf in specific folders! simply drag the field name tags to where you want them. First tick the “organize my files” option, then choose:
- Sort files
- Rename documents
4 Document-types and output-styles

4.1 Different document types
Most used is the journal article, and if your paper and reference comes from one of the larger databases like Springer, Elsevier or Web of Science your reference and citation will be complete. Document types such as reports, MSc and PhD theses and especially websites may take some attention. In general, always check the reference you have just imported to see if all information is there.

When using the ‘save to Mendeley’ button on a website you have been using in your research the author of the website does not appear. As author of a webpage you usually use the Organization or institution that hosts the webpage. In case of a blog you name the person writing the blog.
Corporate authors – organizations as authors of publications

If you manually add the name of the institute, department, organization as author of the webpage, your citation will be clearer and the reference will make more sense. While typing the name of the author you will be offered the option of marking it as an institution/organization.

If for example if “The World Bank” appears as “Bank, T.W.” in your Word documents, add a comma [ , ] after The World Bank, in your Mendeley library, this will keep the name in the same order and Mendeley will not try to change it into a family name with initials.

MSc or PhD theses
To clearly recognize a MSc or a PhD theses you may want to add (MSc thesis) or (PhD thesis) just after the title in your Mendeley record. Use both ‘Book’ as record type for these publications in Mendeley.
4.2. Not every References needs a hyperlink

If with every reference Mendely imports a hyperlink, you can change the settings of the Reference style in two steps.

1. From the Word document, Reference tab menu, select the drop down option next to the name of the Reference style and select ‘more styles’ (see image below)

2. After selecting this, your Mendeley library will open with a styles pop-up where you have the option to select – include URLs and Date Accessed in Bibliography “Only for Webpages” or “For all document types” Standard in APA style is “only for web pages.”
4.3 Output styles

The APA style is one of the most used output and writing styles, the reference list generated following this style is very elegant and complete. Please see this schedule on how may authors are used in citations of papers with more than one author.

Online style library for other output style examples: https://csl.mendeley.com/searchByName/

Citation schedule for APA:

<table>
<thead>
<tr>
<th>Type of citation</th>
<th>First citation in text</th>
<th>Subsequent citations in text</th>
<th>Parenthetical format, first citation in text</th>
<th>Parenthetical format, subsequent citations in text</th>
</tr>
</thead>
<tbody>
<tr>
<td>One work by three authors</td>
<td>Bradley, Ramirez, and Soo (1999)</td>
<td>Bradley et al. (2000)</td>
<td>(Bradley, Ramirez, &amp; Soo, 1999)</td>
<td>(Bradley et al., 1999)</td>
</tr>
<tr>
<td>One work by four authors</td>
<td>Bradley, Ramirez, Soo, and Walsh (2000)</td>
<td>Bradley et al. (2006)</td>
<td>(Bradley, Ramirez, Soo, &amp; Walsh, 2006)</td>
<td>(Bradley et al., 2006)</td>
</tr>
<tr>
<td>One work by six or more authors</td>
<td>Wasserstein et al. (2005)</td>
<td>Wasserstein et al. (2005)</td>
<td>(Wasserstein et al., 2005)</td>
<td>(Wasserstein et al., 2005)</td>
</tr>
</tbody>
</table>

If you prefer to have only one author with each citation, select for example:

- Chicago: manual of style 16th edition or
- Harvard: imperial college London, as an output style.

(Ramoelo et al., 2013)


Others prefer a Numbered style for example “Nature” where each citation is just symbolized by [3] for example instead of the author’s name.


Have a good look at both citations and references before you change your output style.
5. Mendeley and BibTeX / LaTeX

5.1 Export from Mendeley to BibTeX

http://libguides.mit.edu/content.php?pid=241351&sid=1992274

“How do I export from Mendeley to BibTeX?”

Open Mendeley, and within “My Library” found on the left, select references that you would like to export to BibTeX. In the drop-down menu in the toolbar at the top of the screen, click "File --> Export" (or ctrl-E if you use keyboard shortcuts) and in the dropdown list of file types, chose "Save as type: BibTeX" and save to the same location as the LaTeX file.

If you're working with Mendeley on a PC and your manuscript is on Athena, you'll need to save the BibTeX export to your hard drive and use FTP or another file transfer method to transfer the file to the correct directory in your Athena space.

To link the bibliography file that you just downloaded to your document, you need to enter two commands: \bibliographystyle{style} should go just inside your \begin{document} command. style.bst is the name of the style file dictating the format of your bibliography (see How do I change the format of the bibliography? below).

\bibliography{filename} should go wherever you want LaTeX to generate the bibliography. filename.bib is the name of the file that you just downloaded from RefWorks containing your exported references. “ (Green, n.d.)

5.2 Automatically create a BibTeX files

Also from the Tools menu, and options, BibTeX tab you can set Mendeley to automatically create a BibTeX file for each reference in the library.
6. **Mendeley online**

Your online Mendeley library serves as backup and can act as your work platform when you do not have your ‘desktop computer’ at hand.

You can save references, maybe not always with pdf but the synchronization option of Mendeley will import them into your desktop version when you start-up the next time.

Your online storage capacity for the free Mendeley edition is 2GB

Some editing options are also available in the online version
6.1 Create a group

In the free version of Mendeley you can make only one private group of 3 people to share references and your work. You can however make more open groups to share references. In these open groups you can share references when working on a joint project. But you cannot share documents because of copyright.

In the Mendeley institutional Edition, you can create also larger private groups to share references and annotations.

Move references to this group.
- From your desktop library
- Or From the online Mendeley dash

6.2 Participate in groups

Already a lot of people with Mendeley account have joint groups of their interest, it’s possible to search available groups for your topic and see if useful discussions are going round. You can ask to join if it is a closed group, or opt to follow their work.

The option to browse groups offers a nice start to see what’s available.
6.3 Create your own profile

To work with others, share your experience or build your own profile you can create a Mendeley profile on your online account page, click your name as mentioned after login. Now you can edit your profile, change who you want to follow etc.

adding your papers will be offer to you by Mendeley, and of course you can add papers yourself.

By using the DOI in your url colleagues from all over the world with access to e-journals can find the papers you’re listing on your profile. To share these papers the use of author’s copies and pre-publication versions is usually allowed by publishers. Open Access papers know no restrictions in this sense.

REFERENCES